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SYSRPC Utility - Overview
This documentation describes the Natural SYSRPC utility which is used to maintain remote procedure calls. 

New Features with Natural RPC Version 5.1
With (Remote Procedure Call) Version 5.1, the SYSRPC utility provides new features. Features only available
with Natural RPC Version 5.1 are identified with the remark "Only applicable to Natural RPC Version 5.1." at
the top of the relevant pages.

This documentation covers both the new features of the SYSRPC utility under Natural RPC 5.1 and the current
Natural RPC.

For a summary of the new features, see the README.TXT file.

Related topics:

For information on how to apply the SYSRPC utility functions to establish a framework for communication
between server and client systems, refer to the Natural RPC (Remote Procedure Call) documentation. 
For an explanation of expressions relevant to the SYSRPC utility see also Definition of Terms in the
overview page of the Natural RPC documentation. 
The use of SYSRPC may be controlled by Natural Security. See Protecting Natural Utilities in the Natural
Security documentation. 

The SYSRPC Utility documentation covers the following topics:

Basic Functionality: 

RPC 5.1       Current RPC 

Invoking and terminating SYSRPC and commands, functions and
options provided. 

Service Directory Maintenance:  

RPC 5.1 Current RPC 

Maintaining client/server connections. 

Stub Generation Generating client stubs. 

Parameter Maintenance Modifying Natural RPC settings. 

Server Command Execution:  

RPC 5.1    Current RPC 

Ping and Terminate. 
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SYSRPC - Basic Functionality
Only applicable to Natural RPC Version 5.1. 

The SYSRPC utility window contains all elements needed to maintain a service directory and execute all
relevant commands and functions. 

Below is information on: 

Invoking SYSRPC 
Terminating SYSRPC 
Navigation Tree 
Menu Bar 
Toolbar 
Context Menu

Invoking SYSRPC
 To invoke the SYSRPC utility window from the Natural main window 

1.  From the tree directory, choose a library. 
2.  From the Tools menu, choose Configuration Tools and Remote Procedure Call.

Or, in the command line, enter the system command SYSRPC. 

The SYSRPC utility window appears and displays the service directory tree for the library specified. This is
indicated in the name of the directory root node: Service Directory [library-name]. 

When you invoke SYSRPC for the first time for a library, as shown in the example below, the service
directory tree contains example (dummy) data. In addition, the name of the service directory root node is
Example Service Directory which will change to Service Directory [library-name]; for a list of possible root
names, see Root Node Names in the section Service Directory Maintenance. 
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From the SYSRPC utility window you can invoke all functions available for RPC maintenance: 

Service Directory Maintenance
(under Natural RPC 5.1 or current Natural RPC)
Stub Generation
Parameter Maintenance
Server Command Execution
(under Natural RPC 5.1 or current Natural RPC)

See the corresponding sections for a description of these functions.

Terminating SYSRPC
 To exit the SYSRPC utility 

In the SYSRPC utility window, from the Object menu, choose Exit.
Or choose ALT+F4.
Or choose the standard Windows close function. 

If a window appears with a message saying that the subprogram NATCLTGS is missing (needed at runtime),
choose Yes to confirm the generation of NATCLTGS. 

Navigation Tree
The navigation tree in the SYSRPC utility window displays all items (tree nodes) required for service directory
maintenance. Do not confuse a tree node of the Service Directory with the Node used for the remote call, for
example, EntireX Broker name. 

To manipulate the tree nodes, use the commands and functions provided with the menu bar, the toolbar and the 
context menu as described below. 

See Service Directory Maintenance for further information on tree nodes.

You can expand or collapse the tree structure by clicking the plus (+) or minus (-) sign in front of an item.
Alternatively, you may choose the ARROW keys. Double-click an expandable node to display all items
available for this node.

 To expand all nodes of the Tree

In the SYSRPC utility window, right-click the root node and choose Expand Tree.
Or choose CTRL-F12.

Menu Bar
Below is a list of commands and functions available with the menus of the SYSRPC utility window:
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Menu Command Explanation 

Object Open Opens a service directory (for example, NATCLTGS). 

Enter a DBID (database ID) and FNR (file number) for an object stored in a local library.

Save Saves a tree node modification. 

Save As Saves a service directory in another library. 

Properties Invokes the "Properties of Service Directory ..." box. It provides information on the
generation of the service directory:

Object The name of the service directory. 

Generated by   The name of the Natural utility. 

Environment If the directory was generated in a local environment, the value
"local" will be displayed. Otherwise, the name of a remote server
is displayed. 

Library The name of the library in which the service directory was
generated. 

User The ID of the user who generated the service directory. 

Time stamp The day and the time on/at which the service directory was last
modified. 

Expiration The remote directory data are loaded at runtime. The expiration
time determines the period of validity of this data. If directory
data are requested after the expiration time set, they will
automatically be reloaded. If expiration time is set to 0 seconds,
the remote directory data will not be reloaded. 

Exit Terminates SYSRPC. 

Edit New Item Creates a new node item. Depending on the tree node selected, you have the following 
choices:

Node  

Logical Service (EntireX) 

Natural RPC Server 

Library 

Service (subprogram) 

See also Definition of Terms in the overview page of the Natural RPC documentation and 
Location Transparency in the section Service Directory Maintenance for an explanation
of relevant expressions. 

Rename Modifies the name of a tree node. 

Delete Removes a tree node. 

Cut, Copy,
Paste

Cuts, copies or pastes a tree node.
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Menu Command Explanation 

Tools Parameter Invokes the Parameter Maintenance function. 

See the relevant section.

Ping Sends an internal message to verify server connections. 

See the section Command Execution. 

Terminate Sends an internal message to terminate server connections.

See the section Command Execution. 

Stub 
Generation

Invokes the Stub Generation function.  

See the relevant section. 

Help   Displays SYSRPC help text:

SYSRPC Utility - Overview
Command Execution (Ping, Terminate)
LOGON Option
Transport Method
Location Transparency
Navigation Tree
Stub Generation

Toolbar
The toolbar buttons represent the following menu commands:

Add New Node Item (Edit menu) 

Add New Logical Service (EntireX) Item (Edit menu) 

Add New Natural RPC Server Item (Edit menu) 

Add New Library Item (Edit menu) 

Add New Service/Subprogram (Edit menu) 

Ping Natural RPC Server(s) (Tools menu) 

Terminate a Natural RPC Server (Tools menu) 

Context Menu
The context menu provides alternative ways of executing the commands and functions provided with the menu
and the toolbar of the SYSRPC utility window.

Attention:
In addition to the SYSRPC menu and the toolbar, as described in Service Directory Maintenance, the context
menu provides:

the command Expand Tree as described under Navigation Tree above, 
the LOGON Option (see Service Directory Maintenance) and 
the option to specify the Transport Method (see Service Directory Maintenance).
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The context menu does not offer the Parameter Maintenance function as described in the relevant section.
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SYSRPC - Basic Functionality
The SYSRPC utility window contains all elements needed to maintain a service directory and execute all
relevant commands and functions. 

Below is information on: 

Invoking SYSRPC 
Terminating SYSRPC 
Navigation Tree 
Menu Bar 
Toolbar 
Context Menu
(including the LOGON option)

Invoking SYSRPC
 To invoke the SYSRPC utility window from the Natural main window 

1.  From the tree directory, choose a library. 
2.  From the Tools menu, choose Configuration Tools and Remote Procedure Call.

Or, in the command line, enter the system command SYSRPC. 

The SYSRPC utility window appears and displays the service directory tree for the library specified. This is
indicated in the name of the directory root node: Service Directory [library-name]. 

When you invoke SYSRPC for the first time for a library, as shown in the example below, the service
directory tree contains example (dummy) data. In addition, the name of the service directory root node is
Example Service Directory which will change to Service Directory [library-name]; for a list of possible root
names, see Root Node Names in the section Service Directory Maintenance. 

From the SYSRPC utility window you can invoke all functions available for RPC maintenance: 
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Service Directory Maintenance
(including the LOGON Option)
Stub Generation
Parameter Maintenance
Server Command Execution 

See the corresponding sections for a description of these functions.

Terminating SYSRPC
 To exit the SYSRPC utility 

In the SYSRPC utility window, from the Object menu, choose Exit.
Or choose ALT+F4.
Or choose the standard Windows close function. 

If a window appears with a message saying that the subprogram NATCLTGS is missing (needed at runtime),
choose Yes to confirm the generation of NATCLTGS. 

Navigation Tree
The navigation tree in the SYSRPC utility window displays all items (tree nodes) required for service directory
maintenance. Do not confuse a tree node of the Service Directory with the Node used for the remote call, for
example, EntireX Broker name. 

To manipulate the tree nodes, use the commands and functions provided with the menu bar, the toolbar and the 
context menu as described below. 

See Service Directory Maintenance for further information on tree nodes.

You can expand or collapse the tree structure by clicking the plus (+) or minus (-) sign in front of an item.
Alternatively, you may choose the ARROW keys. Double-click an expandable node to display all items
available for this node.

 To expand all nodes of the Tree

In the SYSRPC utility window, right-click the root node and choose Expand Tree.
Or choose CTRL-F12.

Menu Bar
Below is a list of commands and functions available with the menus of the SYSRPC utility window:
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Menu Command Explanation 

Object Open Opens a service directory (for example, NATCLTGS). 

Enter a DBID (database ID) and FNR (file number) for an object stored in a local 
library.

Save Saves a tree node modification. 

Save As Saves a service directory in another library. 

Properties Invokes the "Properties of Service Directory ..." box. It provides information on the
generation of the service directory:

Object The name of the service directory. 

Generated by   The name of the Natural utility. 

Environment If the directory was generated in a local environment, the value
"local" will be displayed. Otherwise, the name of a remote server
is displayed. 

Library The name of the library in which the service directory was
generated. 

User The ID of the user who generated the service directory. 

Time stamp The day and the time on/at which the service directory was last
modified. 

Exit Terminates SYSRPC. 

Edit New Item Creates a new node item. Depending on the tree node selected, you have the following 
choices:

Node  

Natural RPC Server 

Library 

Service (subprogram) 

See also Definition of Terms in the overview page of the Natural RPC documentation
for an explanation of relevant expressions. 

Rename Modifies the name of a tree node. 

Delete Removes a tree node. 

Cut, Copy,
Paste

Cuts, copies or pastes a tree node.
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Menu Command Explanation 

Tools Parameter Invokes the Parameter Maintenance function. 

See the relevant section.

Ping Sends an internal message to verify server connections. 

See the section Command Execution. 

Terminate Sends an internal message to terminate server connections.

See the section Command Execution. 

Stub 
Generation

Invokes the Stub Generation function.  

See the relevant section. 

Help   Displays SYSRPC help text:

SYSRPC Utility - Overview
Command Execution (Ping, Terminate)
LOGON Option
Navigation Tree
Stub Generation

Toolbar
The toolbar buttons represent the following menu commands:

Add New Node Item (Edit menu) 

Add New Natural RPC Server Item (Edit menu) 

Add New Library Item (Edit menu) 

Add New Service/Subprogram (Edit menu) 

Ping Natural RPC Server(s) (Tools menu) 

Terminate a Natural RPC Server (Tools menu) 

Context Menu
The context menu provides alternative ways of executing the commands and functions provided with the menu
and the toolbar of the SYSRPC utility window.

Attention:
In addition to the SYSRPC menu and the toolbar, as described in Service Directory Maintenance, the context
menu provides:

the command Expand Tree as described under Navigation Tree above and 
the LOGON Option (see Service Directory Maintenance).

The context menu does not offer the Parameter Maintenance function as described in the relevant section.
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SYSRPC - Service Directory Maintenance -
RPC 5.1
Only applicable to Natural RPC Version 5.1. 

The SYSRPC utility provides functions used to maintain a service directory in order to connect the client’s
calling program to a subprogram on a server. The service information is stored in the subprogram NATCLTGS
and the XML-formatted file SERVDIRX (Natural text member).

For further information on how to apply the service directory function, refer to Specifying RPC Server 
Addresses as described in Operating a Natural RPC Environment in the Natural RPC documentation.

The following topics are covered below:

Service Directory Concept 
Tree Nodes 
LOGON Option 
Transport Method

Service Directory Concept
The items of a service directory are node, server, library and subprogram. The hierarchical structure of these
items is displayed as a tree view in the navigator of the SYSRPC utility window (see also Tree Navigation in
Basic Functionality). The highest node level (root node) of the tree is Service Directory and the lowest is
Service. 

The node and server names specified in the Service Directory are either physical names or logical names and
logical services.

Below is information on:

Physical Nodes and Servers 
Location Transparency 
Example of Service Directory 
Using Logical Services and Logical Node Names

Physical Nodes and Servers

Physical node and server names denote the names of real nodes (valid TCP/IP or Entire Net-Work address) and 
servers.

In the Example of Service Directory below, two servers are defined for one node. Both servers are connected to
the same node: ETB045. The remote CALLNAT to Subprogram SUB1 is executed on Server NRPC001,
whereas Subprograms SUB2 and SUB3 are executed on Server NRPC002. 

The server names specified here must be identical to the server names used in the Natural parameter module of
the server tasks: see the parameter SRVNAME in the Natural Parameter Reference documentation. Analogously,
the node name in the service directory must be identical to the node name specified for the server tasks: see the
parameter SRVNODE in the Natural Parameter Reference documentation.
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Location Transparency

Location transparency is a concept where physical node names can be replaced by logical names or a
combination of physical node and server names can be replaced by logical services.

Logical node names and logical services are defined with EntireX and are assigned to physical node and server
names at Natural runtime.

Related Topics:

Using Location Transparency in Operating a Natural RPC Environment in the Natural RPC documentation. 
The relevant sections in the EntireX documentation.

In the Example of Service Directory below, the icon    indicates that NRPC001-LOGICAL is a logical service.
LOGBROKER=NODE in the tree node Node indicates that NODE is the logical node name.

Example of Service Directory 

Using Logical Services and Node Names

 To define a logical service

See the functions provided with the menu bar, the toolbar and the context menu as described in Basic
Functionality. 
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 To define a logical node name 

In the tree node Node, replace the existing value by LOGBROKER=node-name
where node-name denotes the logical EntireX Broker name.

 To remove a logical node name 

For a logical node name: in the Node field, remove the string LOGBROKER= and enter the name of an
EntireX Broker. 

 To display physical names defined for logical services or nodes

Use the Ping command as described in the section Server Command Execution.
Ping invokes a window that dispays the physical node and server names defined for a logical service or a
physical node name defined for a logical node.

Tree Nodes
Below is a description of the Service Directory tree nodes. Each tree node is identified by a different icon. 

For a definition of the node names mentioned, see Definition of Terms in the overview page of the Natural RPC 
documentation.

To manipulate the tree nodes, use the commands and functions provided with the menu bar, the toolbar and the 
context menu as described in Basic Functionality.
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Icon Tree Node Explanation 

Service
Directory
root

The service directory root node indicates the name of the library from which the service
directory was read: Service Directory [library-name]. 
For example: If you invoked the SYSRPC utility from the library USERLIB, the root reads
"Service Directory [USERLIB]".

For an explanation of other root node names that may occur, see Root Node Names below.

Node The name of the node to which the remote CALLNAT is sent.

Maximum name length:

Physical nodes: 32 characters 

Logical nodes: 192 characters 

Depending on the setting of the LOGON option, different icons are displayed for Node:

LOGON = No 

LOGON = Yes 

See also LOGON Option below.

Server The name of the server on which the CALLNAT is to be executed.

Maximum name length: 32 characters

Depending on the setting of the LOGON option, different icons are displayed for Server:

LOGON = No 

LOGON = Yes 

See also LOGON Option below.

Logical 
Service

The name of a logical service.

Maximum name length: 192 characters

Depending on the setting of the LOGON option, different icons are displayed for a logical
service: 

LOGON = No 

LOGON = Yes 

See also LOGON Option below.

Library The name of the library to which your client application is currently logged on. SYSTEM
is also allowed. 

Service
(Subprogram)

The name of the remote subprogram to be accessed from the client.

Maximum number of entries: 500 subprograms.
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Root Node Names

Below are the names of root nodes that may occur if the subprograms or files which are required by the Service
Directory Maintenance function are missing, an explanation of what is missing, and instructions on changing the
root node to Service Directory [library-name].

Node Name Reason Resolution 

Service Directory
from NATCLTGS
[library-name]    

The file SERVDIRX is missing. 

This is indicated by the icon  .

From the Options menu choose Save As or,
modify any of the tree node items and choose 
Save.

SERVDIRX is generated into the Text
directory and the name of the root node 
changes.

Example Service
Directory

The subprogram NATCLTGS and the
file SERVDIRX are missing.

From the Options menu choose Save As or,
modify any of the tree node items and choose 
Save.

NATCLTGS and SERVDIRX are generated
into the Subprograms and Text directory
respectively and the name of the root node 
changes.

An empty tree NATCLTGS, SERVDIRX and the
DEF-GS example data (subprogram
delivered in the Natural system library
SYSRPC) are missing.

1.  Create at least one new item for Node and
Server or create at least one logical
service.. 

2.  Save the modifications. 

NATCLTGS and SERVDIRX are generated
into the Subprograms and Text directory
respectively and the name of the root node
changes. 

LOGON Option
If the LOGON option is set, the client initiates a Natural logon to the server with the library name of the current
library on the client, regardless of the library specified in the Service Directory.

After the remote CALLNAT has been executed (successfully or not), the server library is reset to its previous
state. For more information, see Using the Logon Feature in the Natural RPC documentation.

The LOGON can be set on server or node level and applies to all definitions made on a hierarchically lower
level. For example, if the LOGON option has been set for a certain server, it applies to all associated library and
subprogram definitions.

 To set a LOGON

In the Service Directory tree, right-click the name of a Node, Server or Logical Service and select LOGON
Option. 
Choose Yes to initiate the client’s logon to the server.
(The default is No.) 
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If the logon has been initiated successfully for the Node selected, the icon indicating a node changes from 

 to  .
If the logon has been initiated successfully for a Logical Service, the icon indicating a logical service

changes from  to  .
If the logon has been initiated successfully for the Server selected, the icon indicating a server changes from 

 to  . 

Transport Method
 To specify the transport method 

In the Service Directory tree, right-click the name of a Node, Server or Logical Service, select Transport
Method and 

ACI for EntireX Broker ACI protocol (marked by default). 
Or, under OpenVMS, CSCI for Entire Net-Work CSCI protocol. 
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SYSRPC - Service Directory Maintenance
The SYSRPC utility provides functions used to maintain service directories in order to connect the client’s
calling program to a subprogram on a server. The service information is stored in the subprogram NATCLTGS
and the XML-formatted file SERVDIRX (Natural text member).

The items of the service directory are node, server, library and subprogram. The hierarchical structure of these
items is displayed as a tree view in the navigator of the SYSRPC utility window (see also Tree Navigation in
Basic Functionality). The highest node level (root node) of the tree is Service Directory and the lowest Service.

For further information on how to apply the service directory function, refer to Specifying RPC Server 
Addresses as described in Operating a Natural RPC Environment in the Natural RPC documentation.

This section provides information on the node items of the Service Directory tree and the LOGON option. 

The following topics are covered below:

Tree Nodes 
Example of Service Directory 
LOGON Option

Tree Nodes
Below is a description of the Service Directory tree nodes. Each tree node is identified by a different icon. 

For a definition of the node names mentioned, see Definition of Terms in the overview page of the Natural RPC 
documentation.

To manipulate the tree nodes, use the commands and functions provided with the menu bar, the toolbar and the 
context menu as described in Basic Functionality.
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Icon Tree Node Explanation 

Service
Directory
root

The service directory root node indicates the name of the library from which the service
directory was read: Service Directory [library-name]. 
For example: If you invoked the SYSRPC utility from the library SYSTEM, the root reads
"Service Directory [SYSTEM]".

For an explanation of other root node names that may occur, see Root Node Names below.

Node The name of the node to which the remote CALLNAT is sent.

Depending on the setting of the LOGON option, different icons are displayed for Node:

LOGON = No 

LOGON = Yes 

See also LOGON Option below.

Server The name of the server on which the CALLNAT is to be executed.

Depending on the setting of the LOGON option, different icons are displayed for Server:

LOGON = No 

LOGON = Yes 

See also LOGON Option below.

Library The name of the library to which your client application is currently logged on. SYSTEM
is also allowed. 

Service
(Subprogram)

The name of the remote subprogram to be accessed from the client. 

Root Node Names

Below are the names of root nodes that may occur if the subprograms or files which are required by the Service
Directory Maintenance function are missing, an explanation of what is missing, and instructions on changing the
root node to Service Directory [library-name].
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Node Name Reason Resolution 

Service Directory
from NATCLTGS
[library-name]        

The file SERVDIRX is missing. 

This is indicated by the icon  .

From the Options menu choose Save As or,
modify any of the tree node items and choose 
Save.

SERVDIRX is generated into the Text
directory and the name of the root node 
changes.

Example Service
Directory

The subprogram NATCLTGS and the
file SERVDIRX are missing.

From the Options menu choose Save As or,
modify any of the tree node items and choose 
Save.

NATCLTGS and SERVDIRX are generated
into the Subprograms and Text directory
respectively and the name of the root node 
changes.

An empty tree NATCLTGS, SERVDIRX and the
DEF-GS example data (subprogram
delivered in the Natural system library
SYSRPC) are missing.

1.  Create at least one new item for Node
and Server. 

2.  Save the modifications. 

NATCLTGS and SERVDIRX are generated
into the Subprograms and Text directory
respectively. 

Example of Service Directory

In the Example Directory above, two servers are defined for one node. Both servers are connected to the same
node: ETB045. The remote CALLNAT to Subprogram SUB1 is executed on Server NRPC001, whereas
Subprograms SUB2, SUB3 and SUB4 are executed on Server NRPC002. 
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The server names specified here must be identical to the server names used in the Natural parameter module of
the server tasks (parameter SRVNAME: see Profile Parameters in the Natural Parameter Reference
documentation). Analogously, the node name in the service directory must be identical to the node name
specified for the server tasks (parameter SRVNODE: see Profile Parameters in the Natural Parameter Reference 
documentation).

The Service Directory tree provides a maximum of 500 lines for input.

LOGON Option
If the LOGON option is set, the client initiates a Natural logon to the server with the library name of the current
library on the client, regardless of the library specified in the Service Directory.

After the remote CALLNAT has been executed (successfully or not), the server library is reset to its previous
state. For more information, see Using the Logon Feature in the Natural RPC documentation.

The LOGON can be set on server or node level and applies to all definitions made on a hierarchically lower
level. For example, if the LOGON option has been set for a certain server, it applies to all associated library and
subprogram definitions.

 To set a LOGON

In the Service Directory tree, right-click the name of a Node or Server and select LOGON Option. 
Choose Yes to initiate the client’s logon to the server.
(The default is No.)
If the logon has been initiated successfully for the Node selected, the icon indicating a node changes from 

 to  .
If the logon has been initiated successfully for the Server selected, the icon indicating a server changes from 

 to  .
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SYSRPC - Stub Generation
The Stub Generation function is used to generate client stub subprograms. Though stubs are actually not required
if automatic Natural RPC execution is used, it may be advantageous to generate them anyway. 

For more details, see Stubs and Automatic RPC Execution in the section Operating a Natural RPC Environment
in the Natural RPC documentation.

This section covers the following topics:

Invoking Stub Generation 
Fields

Invoking Stub Generation
 Invoking and using the Stub Generation function 

1.  On the SYSRPC utility window, from the Tools menu, choose Stub Generation.
Or right-click a tree node to invoke the context menu and choose Stub Generation.
The "Input for the Stub Generation" box appears.

2.  In the "Input for the Stub Generation" box, check or change (if desired) the entries in the fields: 
Name:
Enter the name of the stub subprogram to be generated.
The name of the stub subprogram must be the same as the name of the remote CALLNAT program. 
Library:
If desired, change the name of the library in which the stub subprogram is to be generated. The name
of the library is preset with the current library. It is possible to generate the stub subprogram direct into
the application library. 
DBID, FNR:
Non-modifiable field. It displays the DBID (database ID) FNR (file number) and type of Natural file
(FNAT = system, FUSER = user) for the library entered. 
Compression:
Choose Compression Type 0, 1 or 2 (default is 1); see Using Compression as described in Operating a
Natural RPC Environment in the Natural RPC documentation. 

3.  Click OK.
If the subprogram specified already exists for the library specified, a window appears asking you if you
want to keep the old definitions: 

If you want to modify an existing stub, click Yes. 
If you want to generate a new stub, click No.

The Stub Generation box appears displaying the parameter data area with filled input fields for the stub
subprogram to be modified, or empty input field for new stubs. Note that you can still keep old definitions,
even after you have entered new values if you abort execution by clicking Cancel. 

4.  In the Stub Generation box, add or modify the parameters to be used in the stub subprogram: 
Enter a value or select it from a drop-down list box (see also Fields below). 

5.  Click OK to generate the stub subprogram and to exit the Stub Generation box. 
The stub subprogram is generated in the current library, which is not usually SYSRPC. 

6.  If the stub was generated in the library SYSRPC, you must move the stub to the application library or
steplib. 
After execution of the Stub Generation function, the stub subprogram exists as source and as cataloged
object. After transferring stub sources into other environments, you must recatalog them.
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Fields
The following fields are provided in the Stub Generation screen:

Field Description 

Attr The attribute which specifies the parameter as: M (modifiable field), O (output field) or I (input
field). 

Type Natural data type, such as N (numeric). Data types C and Handle are not allowed. 

Len Length of the variable. Natural data types A are restricted to 253 bytes, data types B are restricted
to 126 bytes. Dynamic variables are not allowed. 

Prec Only applies to data types N (numeric) and P (packed). Optional. Precision of the variable, that is,
number of digits after the decimal point. 

1./2./3. Dim Only applies to arrays. Optional. First, second and third dimension of the variable. 

Example: 
The following example shows four modifiable parameters that correspond to the following variable definitions in
a Natural program: 

DEFINE DATA
PARAMETER
1 #X001(A10)
1 #X002(I4)
1 #P003(P5.2)
1 #X004(A100/5,4)

Stub Generation 

 Attr Type Len Prec 1. Dim 2. Dim 3. Dim 

1 M A 10      

2 M I 4      

3 M P 5 2     

3 M A 100  5 4 1 
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SYSRPC - Parameter Maintenance
Applies to client sessions only. 

The Parameter Maintenance function is used to dynamically (within a session) modify some of the RPC profile
parameters set in the NATPARM parameter module. 

Attention:
The parameter modifications are retained as long as the user session is active; they are lost when the session is
terminated. Static settings are made using the Natural profile parameters.

This section covers the following topics:

Invoking Parameter Maintenance 
Fields 

Invoking Parameter Maintenance
 To invoke and use the Parameter Maintenance function

On the SYSRPC utility window, from the File menu, select Parameter.
The Parameter Maintenance box appears. 
Modify the values of the input fields (see Fields below). 
Click Apply to save modifications and leave the Parameter Maintenance box open while working with
another SYSRPC function. 
Or click OK to save modifications and exit the Parameter Maintenance box.
Or click Cancel to exit the Parameter Maintenance box without saving modifications.
You will be returned to the SYSRPC utility window. 

Fields
The fields below are provided to specify profile parameters. 

For further information on profile parameter settings, see the section Profile Parameters in the Natural Parameter
Reference documentation. 
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Field Explanation 

Timeout Specifies the number of seconds the client is to wait for an RPC server response.

See the profile parameter TIMEOUT as described in the Natural Parameter Reference 
documentation.

Try Alternative 
Servers

Specifies whether an RPC client is to try to execute a service on an alternative server
(ON) or not (OFF). See also Using an Alternative Server in the Natural RPC 
documentation.

See the profile parameter TRYALT as described in the Natural Parameter Reference 
documentation.

Compression for
AUTORPC = ON

Specifies the compression type for an automatically generated RPC call; see Using 
Compression as described in the Natural RPC documentation.

See the profile parameter COMPR as described in the Natural Parameter Reference 
documentation.

For more information on automatic RPC execution, see Working with Automatic
Natural RPC Execution (Natural RPC documentation).

(Server) Node 
Classification

There are two types of server nodes classified by their node names:

ACI Pattern
(EntireX 
Broker)

Nodes which can be addressed via the EntireX Broker ACI protocol. 

CSCI Pattern   Applies to OpenVMS only.
Nodes which can be addressed via the Entire Net-Work CSCI
protocol. 

See the profile parameters ACIPATT and CSCPATT in the Natural Parameter
Reference documentation.
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SYSRPC - Server Command Execution -
RPC 5.1
Only applicable to Natural RPC Version 5.1.

The SYSRPC utility provides the server execution commands Ping and Terminate. They are used to control
active servers that have been defined in the Service Directory. The Ping command sends an internal message to
verify a server connection. Terminate sends an internal message to terminate a server. 

In addition, when the Ping or Terminate command is issued, the Message Display window that appears displays:

Physical node and server names defined for a logical service, or 
Physical node names defined for logical nodes.

Below is information on:

Message Display Window 
Pinging a Server 
Terminating a Server

Message Display Window
The Ping and Terminate commands invoke the Message Display window. The Message Display window
provides the columns Message, Node and Server to display the message returned from the server and the
physical names of the node or server selected (see the instructions below). 

Physical names are also displayed for logical specifications: a logical node name is resolved into the physical
node name and a logical service is resolved into the physical node and server name as defined in the service 
directory.

However, logical specifications will not be resolved if the following applies:

Logical service: 
The pinged or terminated logical service is not active, or the physical node(s) and server(s) defined for the
logical service have not been defined in the Location Transparency directory of the EntireX Broker. 
In this case, the Message Display window display a corresponding message from the server, the term
*LOCTRAN in the Node column and the logical service name (as defined in the service directory) in the
Server column. 
Logical node:
The pinged or terminated logical node is not active, or the physical node defined for the logical node has not
been defined in the Location Transparency directory of the EntireX Broker.
In this case, the Message Display window displays a corresponding message from the server and the entry 
LOGBROKER=node-name (as defined in the service directory) in the Node column. 

Pinging a Server
 To ping a server

In the Service Directory tree, right-click the name of a Server or a Node and choose Ping.
Or choose CTRL+F9.
Or click the following toolbar button:
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Clicking an EntireX Broker node will ping all servers that belong to this node.
The Message Display window appears displaying the physical names of the node(s) and server(s) and the
message returned from the server(s). 

If the pinged server(s) is active, the server(s) returns the message: "Server V.R.S.PL on operating system",
where 

Server denotes the type of server;
V.R.S.PL is the 1-digit version, R the 1-digit release, S the 1-digit system maintenance level and 
PL the 1- or 2-digit patch level of the server;
operating system denotes on which operating system the server runs.

Example message: Natural RPC Server 5.1.1.0 on WNT-x86.

Terminating a Server
 To terminate a server

In the Service Directory tree, right-click a Server node and choose Terminate.
Or click the following toolbar button: 

The Message Display window appears displaying the names of the node, server(s) and the message returned
from the server(s). 
If a server is terminated, the server(s) returns the message "Terminating Server V.R.S.PL on operating 
system", where 

Server denotes the type of server;
V.R.S.PL is the 1-digit version, R the 1-digit release, S the 1-digit system maintenance level and PL the
1- or 2-digit patch level of the server;
operating system denotes on which operating system the server runs.

Example message: Terminating Natural RPC Server 5.1.1.0 on WNT-x86.

If the LOGON option has been set for a server or a node, logon data (user ID, password and library name) are
sent to the server with the Terminal command, as is usual for the CALLNAT. The Security Token Data window
pops up to request user ID and password if no Natural Security is installed on the client side and no logon data
are set with the USR1071P user exit for the current Natural session.

If LOGONRQ=ON (see also Using Natural RPC with Natural Security in the Natural RPC documentation) has
been set on the server side, logon data must be sent from the client with the Terminate command. 

If Natural Security is installed on the server, the logon data transferred must enable a logon to the library 
SYSRPC.

Terminating a Server with Replicates

When you are running a server with replicates you must terminate each replicate separately using the Terminate
command as described above.

Alternatively, the server can be terminated with the EntireX Broker Control Center or the EntireX System
Management Hub.
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SYSRPC - Server Command Execution
The SYSRPC utility provides the server execution commands Ping and Terminate. They are used to control
active servers that have been defined in the Service Directory. The Ping command sends an internal message to
verify a server connection. Terminate sends an internal message to terminate a server.

Below is information on:

Pinging a Server 
Terminating a Server

Pinging a Server
 To ping a server

In the Service Directory tree, right-click the name of a Server or a Node and choose Ping.
Or choose CTRL+F9.
Or click the following toolbar button:

Clicking an EntireX Broker node will ping all servers that belong to this node.
The Message Display box appears displaying the names of the node, server(s) and the message returned
from the server(s). 

If the pinged server(s) is available, the server(s) returns the message: "Server V.R.S.PL on operating 
system", where 

Server denotes the type of server;
V.R.S.PL is the 1-digit version, R the 1-digit release, S the 1-digit system maintenance level and 
PL the 1- or 2-digit patch level of the server;
operating system denotes on which operating system the server runs.

Example message: Natural RPC Server 5.1.1.0 on WNT-x86.

Terminating a Server
 To terminate a server

In the Service Directory tree, right-click a Server node and choose Terminate.
Or click the following toolbar button: 

The Message Display box appears displaying the names of the node, server(s) and the message returned
from the server(s): "Terminating Server V.R.S.PL on operating system", where 

Server denotes the type of server;
V.R.S.PL is the 1-digit version, R the 1-digit release, S the 1-digit system maintenance level and PL the
1- or 2-digit patch level of the server;
operating system denotes on which operating system the server runs.

Example message: Terminating Natural RPC Server 5.1.1.0 on WNT-x86.
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If the LOGON option has been set for a server or a node, logon data (user ID, password and library name) are
sent to the server with the Terminal command, as is usual for the CALLNAT. The Security Token Data window
pops up to request user ID and password if no Natural Security is installed on the client side and no logon data
are set with the USR1071P user exit for the current Natural session.

If LOGONRQ=ON (see also Using Natural RPC with Natural Security in the Natural RPC documentation) has
been set on the server side, logon data must be sent from the client with the Terminate command. 

If Natural Security is installed on the server, the logon data transferred must enable a logon to the library 
SYSRPC.

Terminating a Server with Replicates

When you are running a server with replicates you must terminate each replicate separately using the Terminate
command as described above.

Alternatively, the server can be terminated with the EntireX Broker Control Center or the EntireX System
Management Hub.
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